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1

Introduction

The purpose of this Course Handbook is to provide you with general information about
studying with the Institute of Commercial Management (ICM). This Handbook should be read
in conjunction with other Guidelines available on the ICM website. The early pages of this
Handbook provide general information about ICM and its programmes. Later sections give
details about the equivalency of ICM Certificate (NQF* Level 4 qualifications), Diploma (NQF
Level 5 qualifications), Advanced Diploma (NQF Level 6 qualifications), Graduate Diploma
(NQF Level 6 qualifications) and Post Graduate Diploma Awards (NQF Level 7
qualifications). Please note that not all Levels are available for all programmes. The material
in this Handbook is as accurate as possible at the time of production.
*NQF: the UK National Qualifications Framework
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The Institute of Commercial Management (ICM)

Established in the early 1970s, the Institute of Commercial Management provides academic
and vocational qualifications which are well recognised globally.
In its capacity as a course developer and an examining and certifying Board, the Institute
offers a wide range of professional and vocational awards in Business, Management and
related vocational areas.
ICM programmes are designed to address the personal development and training needs of
those wishing to enter the commercial sector and to support the continued development and
workplace flexibility of those already in employment.
ICM’s global services include the design, development and certification of business
education and training programmes for education providers; the development and
certification of tailored education and training programmes for the corporate sector,
emerging industries and the global workforce and the examination, assessment and
certification of students undertaking business, management and related vocational education
programmes.
An acknowledged specialist in the design and development of progressive, practical and
multi-functional programmes of study, the Institute works with a range of public and private
sector clients including universities, business schools, colleges, training providers,
International Development Agencies, government agencies and local authorities.
ICM provides examinations in more than 200 subject areas ranging from accounting and
finance to tourism and hospitality and from marketing and advertising to project management
and examines and certifies candidates to an internationally consistent standard.
3

ICM Articulation Agreements with Universities

The Institute has formal partnership arrangements with universities in the UK and overseas.
A full list of progression routes from ICM qualifications into Undergraduate and Post
Graduate courses at UK Universities is available from the ICM website.
Established articulation arrangements provide direct access to the second and final years of
a wide range of BA/BSc degrees for ICM Diploma qualifications (Level 5 Diploma) and
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Advanced Diploma qualifications (Level 6 Diploma). Access to Masters programmes also
exist for those with ICM Graduate Diplomas (Level 6) and ICM Post Graduate Diplomas
(Level 7). In addition, ICM Certificate (Level 4 Diploma) holders may be eligible for entry to
year 1 of appropriate degrees.
Subject to status and grades obtained, students holding ICM Diploma qualifications at levels
4, 5, 6 and 7 are accepted onto Undergraduate and Post Graduate degree programmes
offered by institutions in continents across the globe.
Our strategic partners have agreed that students can enter their degree programmes with
Advanced Standing, provided they possess the right Grade profile and are able to meet
other admissions criteria, such as language competence. The stated grade and points
requirements may be subject to local variations.
Entry to the First Year
Application for entry to the first year of a relevant degree programme will be considered for
those students who hold a relevant ICM Certificate Level Award.
Entry to the Second Year
Application for entry to the second year of an Honours degree programme will be considered
for students who have passed a relevant ICM Diploma (Level 5) programme and have met
the following requirements:
 obtained at least 24 Points from 8 subjects leading to the qualification
 obtained at least a Grade C in all subjects in the Diploma
Entry to the Final Year
Students who have passed a relevant ICM Advanced Diploma (Level 6 Diploma) programme
will be considered for final year entry if they have achieved the following:
 obtained at least 32 Points from 12 subjects leading to the Advanced Diploma
 obtained at least a Grade C in all subjects in the Advanced Diploma
Entry to the Post Graduate Year
Students who have passed a relevant ICM Graduate Diploma (Level 6 Diploma) programme
will be considered for entry to Masters programmes if they have achieved the following:
 obtained at least 12 Points from the final 4 subjects leading to the qualification
 obtained at least a Grade C in all subjects in the Graduate Diploma

Converting ICM subject grades into points
The following rules apply in relation to converting ICM subject grades into points:





an ‘A’ grade is awarded 6 points
a ‘B’ grade is awarded 4 points
a ‘C’ grade is awarded 2 points
a ‘D’ grade is awarded 0 point
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Progression Routes
Students wishing to progress to degree programmes should review the range of courses
available at our partner Universities. Information on appropriate university courses can be
obtained from our website.
The Institute’s qualifications are also recognised by leading professional examining bodies
for either subject exemption or registration purposes. Further details can be obtained from
the appropriate examination bodies.

4

Learning, Teaching and Assessment Strategy

Tuition in preparation for the Institute’s examinations takes place on a number of levels,
including lectures, seminars, class discussion and problem review and analysis.
Formal lectures provide a foundation of information, which students build on through directed
learning and self-managed study outside the classroom.
Students are actively encouraged to form study groups to discuss course material, fostering
a greater depth of learning experience.

4.1 Assessment
Assessment for the majority of programmes is based on final examinations. The Institute has
a traditional approach to assessment. Formative assessment is provided by ICM Teaching
Centres as and when appropriate and may include; essays, in-class tests, role play
exercises, presentations and projects. However, in terms of gaining a professional
qualification, and in order to maintain standards, ICM believes that students should be
formally assessed on the body of knowledge covered during the course and be examined as
individuals on the required learning outcomes.
4.2 Student Workload
In accordance with nationally accepted codes of practice in the UK, each 20 credit unit
represents a total of approximately 200 hours of learning. Typically, each ICM award at
undergraduate level comprises four units of 20 credits each. Students must complete four
units at each level leading to the awards of Certificate (Level 4 Diploma), Diploma (Level 5
Diploma), Advanced Diploma (Level 6 Diploma) and Graduate Diploma (Level 6 Diploma).
Thus, for example, in order to gain an ICM Advanced Diploma, a student must have
completed the Certificate, Diploma and Advanced Diploma stages. The Post Graduate
Diploma (Level 7 Diploma) consists of 120 credits divided into six units.
The learning hours for each unit are subdivided into appropriate categories of learning
opportunities, such as lectures, seminars, preparation time, directed study, time spent on
assessment items and exam preparation. At least one quarter of this time is usually devoted
to formal contact time.
A further one quarter of this time is related to directed learning. The balance of workload is
comprised of individual, self-managed student learning and revision.
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Note that for a unit delivered in standard mode, the ICM examinations calendar
accommodates a teaching year of approximately 2 x 20 teaching weeks, and four weeks of
revision/end of year assessment.
Furthermore, each unit is assigned to a particular ‘Level’, with each Level corresponding to
the group of subjects contained within the programmes leading to the award of a Certificate
(Level 4 Diploma), Diploma (Level 5 Diploma), Advanced Diploma (Level 6 Diploma),
Graduate Diploma (Level 6 Diploma) or Post Graduate Diploma (Level 7 Diploma).
5

ICM Qualifications and Progression

Understanding your qualification is important and the following guidelines outline how ICM
qualifications fit within the UK National Qualifications Framework and support vocational
learning.
ICM has benchmarked its qualifications against the UK National Qualifications Framework
(NQF). In recognition of the NQF levels and with reference to appropriate National
Occupational Standards, the Institute has produced the following level descriptors which
should be read in conjunction with the table provided in section 5.6.
5.1 ICM Certificates (equivalent to NQF Level 4 Diplomas)
ICM Certificates are awarded to those who have passed Part 1 (the first four or five subjects,
depending on the course) of an ICM Diploma programme. See below for ICM Diploma Entry
Requirements. ICM Certificates represent a level of qualification that recognises the ability to
gain, and where relevant apply a range of knowledge, skills and understanding.
ICM Certificate holders should be able to display competence in the application of
knowledge in the performance of a range of work activities, some of which may be routine
and predictable with some being complex or non-routine.
Learning at this level involves gaining knowledge and skills appropriate for individuals
working semi-independently, or receiving basic supervision and training from others in their
field of work.
Students should begin to develop a degree of individual responsibility or autonomy in their
study as well as the ability to collaborate with others, for example through participation in
work groups or teams.
Successful completion of the ICM Certificate enables entry to the first year of appropriate
degree programmes at a range of Universities. For a complete list of progression routes
please refer to the website.
5.2 ICM Diplomas (equivalent to NQF Level 5 Diplomas)
Entry to an ICM Diploma programme requires completion of secondary education or an
equivalent and recognised programme of study.
ICM Diplomas represent a level of qualification which recognises the ability to gain, and
where relevant apply a range of knowledge, skills and understanding.
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ICM Diploma holders should be able to display competence in the application of knowledge
in a broad range of varied work activities performed in a wide variety of contexts, most of
which are complex and non-routine.
Learning at this level involves obtaining detailed knowledge and skills appropriate for people
working independently, or providing basic supervision and training of others in their field of
work and people wishing to go to University.
Progression is available from the ICM Diploma to the second year of relevant degree
programmes at a range of Universities. For a complete list of progression routes please refer
to the website.
5.3 ICM Advanced Diplomas (equivalent to NQF Level 6 Diplomas)
Entry to an ICM Advanced Diploma programme requires completion of the ICM Certificate
and Diploma in the selected programme. Students holding other relevant and equivalent
qualifications which contain ICM Diploma subjects could qualify for entry as well as subject
and Level exemptions.
ICM Advanced Diplomas represent a level of qualification which involves specialist learning
and detailed analysis of a high level of information, knowledge and skills in a specified area
of work or study.
Students undertaking an ICM Advanced Diploma should demonstrate the depth of
knowledge and understanding of an area of work or study to enable them to formulate
solutions and responses to complex problems and situations.
ICM Advanced Diplomas are appropriate for people working in positions such as Senior
Supervisors, Professionals or Managers. These individuals need to demonstrate significant
levels of knowledge, a high level of work expertise in job roles and competence in managing
and training others. Learning at this level is appropriate for people working in technical and
professional jobs, and/or managing and developing others.
The ICM Advanced Diploma is equivalent to NQF Level 6 and in terms of level and credit
value these qualifications are comparable to UK Intermediate Higher Education qualifications
such as HNDs, Diplomas of Higher Education and Foundation Degrees.
Progression is available from ICM Advanced Diplomas to the final year of relevant degree
programmes at a range of Universities. For a complete list of progression routes please refer
to the website.

5.4

ICM Graduate Diplomas (equivalent to NQF Level 6 Diplomas)

Entry to an ICM Graduate Diploma programme requires prior completion of the ICM Diploma
and Advanced Diploma in the selected programme.
Advanced Standing and Exemptions: Students holding relevant degrees and equivalent
qualifications which contain ICM Certificate, Diploma and Advanced Diploma subjects could
qualify for entry as well as subject and Level exemptions.
Students at this level study highly developed and complex levels of knowledge enabling the
development of in-depth and original responses to complicated and unpredictable problems
and situations.
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Learning at the Graduate Diploma level involves the demonstration of high level specialist
professional knowledge appropriate for senior professionals and managers. Indicative
competencies involve the application of a range of fundamental principles across a wide and
often unpredictable variety of contexts as well as the ability to perform technical or
professional work activities in a variety of contexts with a substantial degree of personal
responsibility and autonomy.
A qualification at this level is appropriate for people working as knowledge-based
professionals or in professional management positions. This qualification is equivalent to a
Bachelors degree, and progression is available from the ICM Graduate Diploma to Post
Graduate programmes such as Masters degrees.
5.5 ICM Post Graduate Diplomas (equivalent to NQF Level 7 Diplomas)
Entry to an ICM Post Graduate Diploma programme requires completion of an ICM
Graduate Diploma, another Level 6 award, or a degree level qualification in an appropriate
discipline.
Refer to Section 6 for Advanced Standing arrangements for mature candidates.
Students at this level of study should display a mastery of high level knowledge and skills
and have professional and research-based skills.
This qualification is equivalent to two thirds of a Masters degree (MBA or MA) and advanced
standing can be given onto a range of Masters degrees. For a complete list of progression
routes please refer to the website.

5.6

Relative Positioning of ICM Qualifications

The following table gives an indication of the relative positioning of ICM awards, compared
with other types of qualifications and levels. Reference is made to levels in the UK National
Qualifications Framework and example qualifications at each level. In addition, the final
column in the table (FHEQ) shows the ‘equivalent’ qualifications commonly being developed
and delivered in the University sector. For example, these indicate that the ICM Advanced
Diploma equates to an intermediate level award (in terms of credit accumulation this ICM
qualification equates to a Higher National Diploma). Furthermore, the ICM Graduate Diploma
equates to a Bachelors degree level qualification and the ICM Post Graduate Diploma
equates to a Masters degree level qualification.
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Relative Positioning of ICM Qualifications

National Qualifications Framework
Framework for
(Levels and example vocational
ICM Levels
qualifications)
Level 7
Professional Diploma in Translation

Level 6
Diploma in Management

ICM Post Graduate
Diploma
(Level 7 Diploma)

M (masters), Masters
degrees, Post Graduate
certificates and diplomas

ICM
Graduate Diploma
(Level 6 Diploma)

H (honours)
Bachelors degrees
(BSc/BA)

ICM
Advanced Diploma
(Level 6 Diploma)

I (intermediate)
Diplomas of higher
education, foundation
degrees, Higher National
Diplomas

Level 5
ICM Diploma
BTEC Higher National Diploma in 3D
(Level 5 Diploma)
Design
Level 4
Certificate in Early Years Practice

Framework for
Higher Education
Qualification Levels
(FHEQ)

ICM Diploma
(Level 5 Diploma)

C (certificate)
Certificates of higher
education

Level 3
Certificate in Small Animal Care
NVQ in Aeronautical Engineering
A levels
Level 2
Diploma for Beauty Specialists
NVQ in Agricultural Crop Production
GCSEs Grades A*-C
Level 1
Certificate in Motor Vehicle Studies
NVQ in Bakery
GCSEs Grades D-G
Entry – e.g. Entry Level Certificate in
Adult Literacy
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Student Registration & Course/Level Entry Requirements

6.1 Student Registration
In order to undertake any ICM examination candidates must be Registered ICM Student
Members.
Student Membership can be obtained by completing the appropriate Student Registration
Application form and returning the form and the Student Registration Fee to the Institute.
Details of Student Registration Fees can be found on the ICM website.
The Student Registration fee is valid for one year and can be renewed annually.
Important Note: All students wishing to register for any ICM Advanced Diploma
programme or above, MUST complete and attach an Academic History form to their
Student Registration form. Copies of all qualifications and Awards obtained by the
student must also accompany the Academic History form.
The Academic History form is used to ensure that students are qualified to commence
their studies at the Level they have selected.

6.2 Student Registration Fees
Student Registration fees for standard ICM Awards and programmes are based on the
country in which you will undertake your examinations. The current fees levels are as
follows:
Group 1: If you are based in Europe, and EU Member State, North America, a Gulf
State, India, the Middle East, Australasia, Singapore, South Africa, China,
Hong Kong or Malaysia your Registration Fee will be £50.00 Pounds
Sterling.
Group 2: If you are based in sub-Saharan Africa, Central or South America,
Pakistan, Bangladesh, the Caribbean or North Africa your Registration
Fee will be £25.00 Pounds Sterling.
Group 3: A special rate exists for students in countries which have (a) emerged
from conflict (b) countries in which the general population is subject to
great poverty and (c) countries in which the UN acknowledge that the level
of economic activity and national per capita income is unacceptably low.

6.3

Course/Level Entry Requirements

ICM professional programmes are structured in ‘Levels’. These Levels are designed to
provide a structured and progressive level of knowledge.
All students are required to commence their studies at the Diploma Level of all programmes
unless they are able to claim subject-for-subject or Level exemptions.
Subject-for-subject exemptions can be applied for if the student has (a) been examined, in
the subject, by another recognised Awarding body and (b) has passed the examination/s set
by the alternate body.
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The Institute operates an 'Open Entry' policy in respect of most of its Diploma Level
vocational programmes, subject to appropriate work experience, but prospective students
should note that the following qualifications are recommended for those wishing to undertake
ICM Diploma Level programmes:

Entry to an ICM Diploma Level Programme (NQF Level 5)
Entry to an ICM Diploma programme requires completion of secondary education or
equivalent. For example:
 One GCE A-level plus three GCSEs (or equivalents) or 5 GCSEs
 A suitable BTEC National Award
 Any qualification equivalent to one or more of the above
The minimum age for registration for the majority of programmes is 18. Applicants over the
age of 20 who do not hold one of the recommended entry qualifications may also register for
some Diploma Level programmes providing they have been in full-time employment for a
minimum of two years and can produce a letter from their employer to confirm this.

Entry to an ICM Advanced Diploma Programme (NQF Level 6)
Entry to an ICM Advanced Diploma programme requires completion of the ICM Diploma
Level of the selected programme.

Entry to an ICM Graduate Diploma Programme (NQF Level 6)
Entry to an ICM Graduate Diploma requires completion of the ICM Diploma and Advanced
Diploma in the selected programme.

Entry to an ICM Post Graduate Diploma Programme (NQF Level 7)
Registration for an ICM Post Graduate Diploma is accepted from those:
 who have completed an ICM Graduate Diploma
 who hold any Level 6 business or management Award
 holders of business and management degree level qualifications

Mature Candidates. Applications from those over the age of 25 who do not meet the
standard Entry Requirements will also be considered providing they:
 Are over the age of 25
 Have been in employment for 5 years – a letter of support is required from the
applicant’s employer; and
 Hold a management or senior supervisory position.
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7

Examinations and Results

7.1 Examinations
In order to achieve a consistent global standard the Institute sets all examination papers and
all candidate scripts are returned to the Institute for marking.
Invigilation of examinations is undertaken either by external Invigilators who are appointed
by the Institute or by the British Council. Examinations are held in March, June, September
and December and the Examination Timetable can be found on the ICM website.
Candidates must be registered and paid-up Student Members of the Institute at the time they
undertake their examinations. Examination papers are securely distributed to ICM Approved
Centres and scripts are assessed and moderated in the UK by ICM Appointed Examiners.
Full details of Examination dates can be found on the ICM website.

7.2 Examination Entry Fees and Forms
Examination Entry fees are shown on the appropriate Examination Entry form for the
subject/programme you are undertaking. In general, the standard Examination fee is £26.00
Pounds Sterling per subject. There are however some specialist programmes where a
higher subject fee may be payable. If you have any queries relating to fees please contact
your Teaching Centre.
In order to undertake any ICM Professional or Single Subject examination you must be a
Registered and paid-up ICM Student Member.
To enter for an examination you need to complete the relevant Examination Entry form and
submit it to the Institute.
7.3 Examination Timetable
ICM examinations take place four times each year, in March, June, September and
December. The Timetable for each year states the Closing Date for receipt of entries for
each examination Series. Please visit the website to view the ICM examination timetable.
7.4

Examination grades and re-marking

You can request that your examination script is re-marked if you are unhappy with your
result.
The fee for this is £35.00 Pounds Sterling per script. The Institute operates a triple marking
and moderation system. In the event that the moderator increases the original marks
awarded, the fee for re-marking your script will be refunded to you. Should the Grade
awarded remain the same, you will be issued with a full Examiner’s Report detailing your
examination performance. The Institute retains answer scripts for a maximum period of six
months. Examination scripts/answer books are not returned to candidates under any
circumstances.
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7.5

Examination re-sits

Although ICM Examinations are held every twelve weeks it should be noted that it takes an
average of twelve weeks to mark the scripts after each Examination Series.
If you sit, for example, for one or more subjects in March you will not receive your results
until June. This means that if you were to fail a subject in March, you would not be able to resit the subject in June, as you will have missed the Closing Date for the June Series.
Our advice is that you try to split your subject examinations between two consecutive
Examination Series e.g. If your programme has four subjects you could take two subjects in
one series and two in another series.
On this basis, were you to fail one subject in March you would be able to re-sit it in
September, giving you plenty of time for revision.

7.6

Examination Closing Dates

There is a Closing Date for receipt of Examination Entries and candidates entering for
examinations must ensure that their completed Examination Entry forms and fees reach the
Institute before the Closing Date for each Examination Series. Examination Timetables
indicate the closing date for receipt of entries for each sitting and this information also
appears on the ICM website. Entries received after the Closing Date are automatically
carried forward to the next Examination Series.

7.7

Examination Results

Results are distributed within twelve weeks from receipt of scripts. Candidates are advised
not to telephone the Institute for results as this information is confidential and cannot be
disclosed over the telephone.

7.8

Examination Grades

Should you wish to re-sit any examination to improve your previous Grade, please note that
the latest Grade you obtain will stand.
7.9

Transcript of Academic Results

You may request a transcript of your Academic Results, however please note there is a
charge of £15.00 Pounds Sterling for each Award transcript requested.

7.10 Replacement Certificates
Replacement certificates are available on payment of a fee of £20.00 Pounds Sterling per
certificate. Please include your Student Registration Number together with your current
postal address and indicate which certificate is required.
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7.11 Deferrals
There is a fee of £15.00 Pounds Sterling per subject should you wish to defer your
examinations to another Series for health or for any other reason. If you are unable to
undertake your examinations, it is essential you advise ICM before the appropriate
examination date, otherwise the full entry fee of £26.00 Pounds Sterling will be applicable.
Please note that you may only defer examinations on one occasion. The full entry fee of
£26.00 Pounds Sterling per subject will become due if you defer on more than one occasion.
7.12 Subject Exemptions for Professional Programmes
Students holding relevant recognised qualifications from other professional bodies or
recognised Higher Education institutions may apply for Subject Exemptions, on a subject-forsubject basis. It may also be possible, subject to qualifications held, to obtain exemption
from a Level within a programme. Documentary evidence is required before any decision
can be made in connection with the granting of Subject/Level Exemptions. No exemptions
are given for case studies or assignments. Internally awarded school certificates and
diplomas are not accepted for exemption purposes.

7.13 Single Subject Candidates
Registered ICM students who do not want to complete a full ICM programme may study
individual subjects. Single Subject candidates receive a Single Subject Diploma on
successful completion of the relevant subject examination. Single Subjects qualify, on a
subject-for-subject basis, for subject exemptions from ICM professional programmes.
Note: 1. Case Studies, Assignments and Projects, including ALL subjects in any Post
Graduate programme, do not qualify for Single Subject Awards.
2. A student who undertakes, on a Single Subject basis, subjects within a Diploma,
Advanced Diploma, Graduate Diploma or Post Graduate ICM programme will not
be entitled to a professional Award unless they are exempted from or have
completed all lower Levels of that Award.
3. In order to comply with UKBA requirements, overseas students studying in the UK
(excluding those from EU countries) are not permitted to undertake Single
Subjects and must undertake a professional programme.
8

Subject advice, educational guidance and student support

You are expected to be independent and to take responsibility for your own academic and
personal life. However, your study centre should also provide appropriate help and
assistance. Your tutors will direct your studies and ensure that you know what work you
need to cover in any given unit. Seek advice from academic staff either during or after class
or try to see them during their office hours.

8.1 Study Methods
Teaching Centres are provided with a detailed syllabus and reading list for each subject
area. Each Unit Syllabus clearly defines the areas that you will be required to cover for each
subject and your examination questions will be based on the areas and topics detailed for
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each unit. It is important to ensure that you obtain a copy of each unit syllabus from your
Teaching Centre. Alternatively, this information can be obtained online at
www.icm.education, in the ‘Single Subject’ section.
Each Unit Syllabus is normally linked to one main textbook and the examiners base their
questions on the contents of the nominated core text.
The Unit Syllabuses also give details of 'Alternative Texts' and texts recommended for
further reading. It is advised that you should refer to the 'Alternative Texts' in order to
develop your skills and broaden your knowledge of the subject area.
8.2 Payment Methods
For our accepted methods of payment please refer to the ICM website: www.icm.education

8.3 Choosing your course of study
As an ICM Student Member you can work towards obtaining either a recognised
Professional qualification or study for one or more of the 200 Single Subject Awards from the
list of subjects offered by the Institute. The choice is yours.
8.4 ICM Approved Centres
Tuition leading to the Institute’s examinations can only be provided by Institutions which
have been granted ICM ‘Approved Centre’ status. Please note that some ICM Teaching
Centres specialise in particular subject areas and not all ICM Centres will necessarily offer
tuition for every ICM course programme. Visit the website to find an ICM Approved Centre
near you.
9

Textbooks

The recommended textbooks for each subject are shown on each subject syllabus.
Examiners base their questions on the contents of the recommended texts and it is therefore
important for you to ensure that you have access to the appropriate texts. You can obtain the
full list of books available to purchase from ICM and/or place orders by either contacting your
Centre or complete the Book Order Form and send it to ICM’s Book Sales Manager at:
info@icm.education .

10 Students with specific learning difficulties
If you are diagnosed with a specific learning difficulty you may be granted special
arrangements for your examination/s. We will require a copy of an Assessment Report
issued within the last three years. The amount of additional time and any other
arrangements will be determined on the basis of the Report relating to your circumstances. It
is possible that you may be granted permission to use a computer or laptop without internet
connection in your examinations.
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11 Copies of past examination papers and other forms of assessment
The ICM website, www.icm.education, provides a database of recent examination papers,
assignments and Case Studies. These can be found in the Student Resources section of the
website.
12

Unit Information

Covering all the major business studies areas and topics, the ICM Diploma and Advanced
Diploma programmes have, over a fifteen year period, achieved international recognition and
are currently undertaken by students in over 40 countries.
12.1 Programme Objectives
This programme is designed for those students who wish to develop project management
skills. In addition, the qualification is designed to assist students by:
 increasing their employment opportunities
 providing them with a qualification which will enable them to progress to higher
level general management or specialised business programmes at a later stage
in their business or academic careers
The programme is also suitable for managers who require a recognised business studies
qualification for career advancement and promotion purposes.
12.2

Recommended Course Duration

To help calculate the duration of the programme, please refer to the section entitled ‘Student
Work Load’ in section 3.2 of this handbook.
It is expected that a student will need at least 18 months to 2 years of full-time study at an
ICM Approved Centre to complete the full Advanced Diploma programme.
Examination Grades
Grade A – Distinction

70% and above

Grade B – Credit

60% to 69%

Grade C – Pass

50% to 59%

Grade D – Pass

40% to 49%

Grade F – Fail

39% and under

Certification
On successful completion of all six units students are awarded the ICM Advanced Diploma
in Project Management.
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12.3 Continuing Education
ICM Advanced Diploma Awards enable the student to apply for direct entry into the final year
of a relevant 3 year degree programme.
12.4 Entry Requirements
Students holding relevant recognised qualifications from other institutions or professional
examining bodies may apply for exemptions on a subject-for-subject basis.
The Institute operates an 'Open Access' policy in respect of many of its vocational
programmes but prospective students should note that the following entrance qualifications
are recommended for those wishing to undertake the ICM Advanced Diploma programme:
The minimum age for registration for this programme is 18.
 Entry to an ICM Advanced Diploma programme requires completion of the ICM
Diploma Level of the selected programme
 A suitable BTEC National Award
 Any business studies qualification equivalent to one of the above
Applicants over the age of 20 who do not hold one of the recommended entrance
qualifications may also register for the programme providing they have been in full-time
employment for a minimum of two years.
Important Note: All students wishing to register for any ICM Advanced Diploma
programme or above MUST complete and attach an Academic History form to their
Student Registration form. Copies of all qualifications and Awards obtained by the
student must also accompany the Academic History form.
The Academic History form is used to ensure that students are qualified to commence
their studies at the Level they have selected.
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13

Course Structure

The Advanced Diploma in Project Management
1. Computers & Project Management
2. Managing Work & Costs
3. Nature & Organisation of Project Management
4. Planning & Scheduling
5. Purchasing & Materials Management
6. The Financial & Commercial Framework

The Advanced Diploma in Project Management is awarded on completion of all the above
subjects

13.1 Unit Syllabuses
Syllabuses for this programme are contained in the following sections.

Project Management
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13.1.1 Computers & Project Management Syllabus

Unit Title

Computers & Project Management

Unit Code

CPM-0913

Level

6 Diploma

Credits

20

Unit Leader

KE

Pre-requisites
Main Aim(s) of the Unit:
This unit is designed for those students who wish to develop project management skills.
Main Topics of Study:
Project Management Computer Systems – Preparation
► Scheduling
► Facilities
► System requirements
► Program selection
► Network logic requirements
► Computer schedule preparation
Project Management Computer Systems – Typical
► System and software
► Error prevention and checking
► Network plotting
► Resource scheduling
► Output reports
► Updating
Project Management Computer Systems – Specialised Applications
► Dealing with large networks
► Multi-project resource scheduling
► Standard networks
► Standard sub-network modules or templates
► Programs for probability and risk analysis
► Software sources
Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Describe how computer systems can be utilised in project management tasks.

2.

Use project management techniques in the management and resourcing of projects.

3.

Understand computer systems requirements in the management of projects.
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4.

Evaluate the sue of networks in scheduling and resource allocation.

Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the learning
outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Project Management, Dennis Lock, Gower
Alternative Texts and Further Reading
Project Risk Management: Processes, Techniques & Insights, C.B. Chapman & S.A. Ward, Wiley
Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
Tutorial support includes feedback on assignments and may vary by college according
to local needs and wishes.

50 hours

Directed learning
Advance reading and preparation / Class preparation / Background reading / Group
study / Portfolio / Diary etc.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the tutor
and other students and to undertake further reading using the web and/or libraries.

Project Management

18

13.1.2 Managing Work & Costs Syllabus

Unit Title

Managing Work & Costs

Unit Code

MWC-0913

Level

6 Diploma

Credits

20

Unit Leader

KE

Pre-requisites
Main Aim(s) of the Unit:
This unit aims to equip students with the knowledge to manage projects with regards to the works
and costs involved.
Main Topics of Study:
Implementing the Programme
► Project authorisation
► Authorising work without a contract or order
► Preliminary organisation of the project
► Correspondence and other projects
► Project engineering standards and procedures
► Physical preparation and organisation
► Getting work started
► Issuing detailed planning and work instructions
Managing Progress
► Closed loop control system
► Routine collection of progress data
► Non-routine approach to progressing
► Managing subcontractors and agency employees
► Routine priority allocation in manufacturing projects
► Bad news
► Corrective measures
► Immediate action orders
► Haste versus good management
► Construction site organisation and management
► Progress meetings
► Project reports
Changes and Production Permits
► Classification of changes
► Authorisation arrangements
► General administration
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► Estimating design modification costs
► Forms and procedures
► Modifying drawings
► Emergency modifications
Cost Management – Principles
► Objectives of project cost management
► Cost management factors
► Total cost approach
► Budgets
► Cost collection methods
► Audits
► Comparing actual and planned costs
Cost Management – Evaluation, Prediction and Reporting
► Milestone analysis
► Earned value analysis
► Earned value analysis prediction reliability and implications
► Evaluating cost performance for materials and bought out equipment
► Effect of modifications on earned value analysis
► Project ledger concept
► Predicting profitability
► Post mortem
Final Project Definition and Closure
► Formal project closure
► Final project cost records
► Disposal of surplus material stocks
► Final project definition
► As-built condition
► Managing files and archives
Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Understand the issues involved in starting and implementing major projects.

2.

Utilise a variety of techniques in the managing the progress of projects.

3.

Understand problems involved with project modifications and changes.

4.

Describe the principles of cost management in a project context.
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Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the learning
outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Project Management, Dennis Lock, Gower
Alternative Texts
Getting the Job Done: Managing Project Teams & Task Forces for Success, W.A. Randolph,
Prentice-Hall
Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
These interactive sessions will be used to discuss concepts and allow students to
present findings.

50 hours

Directed learning
Advance reading and preparation / Background research / individual and group
preparation for seminars.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the tutor
and other students and to undertake further reading using the web and/or libraries.
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13.1.3 Nature & Organisation of Project Management Syllabus

Unit Title

Nature & Organisation of Project Management

Unit Code

NOPM-0913

Level

6 Diploma

Credits

20

Unit Leader

KE

Pre-requisites
Main Aim(s) of the Unit:
This unit aims to give students the understanding necessary to develop project management skills.
Main Topics of Study:
Nature and Purpose of Project Management
Types of Project
► Engineering and mining
► Manufacturing
► Management
► Research
Project Objectives
► Performance and quality
► Budget
► Time to completion
Balancing Project Objectives
► Time/cost relationship
► Quality/cost relationship
Effective Project Organisation and Communications
► Communications
► Need for a project manager’s role
Project Organisation Categories
► Functional
► Matrix – the case for and against
► Project team – the case for and against
► The hybrid option
► Organisation of central administration
Project Manager
► Title and role
► Seniority
► Personality
► Use of information
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► Knowledge and awareness
► Support and co-operation
► Project services group
Multiple Project Managers
► Customer’s project manager
► Customer/supplier chains
► Contract matrix
► Joint ventures
PRINCE 2
► Project management processes
► Organisation
► Roles
Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Distinguish different projects and describe project objectives.

2.

Compare the conflicting requirements of time, cost and quality.

3.

Describe different project management categories and processes.

4.

Compare the roles involved in a large project management team.

Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the learning
outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Project Management, Dennis Lock, Gower
Alternative Texts
The Management of Projects, P.W.G. Morris, Thomas Telford
Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

50 hours

100 hours

Lectures / Seminars / Tutorials / Workshops
These interactive sessions will be used to discuss concepts and allow students to
present findings.
Directed learning
Advance reading and preparation / Background research / individual and group
preparation for seminars.
Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the tutor
and other students and to undertake further reading using the web and/or libraries.

Project Management

23

13.1.4 Planning & Scheduling Syllabus

Unit Title

Planning & Scheduling

Unit Code

PS-0913

Level

6 Diploma

Credits

20

Unit Leader

KE

Pre-requisites
Main Aim(s) of the Unit:
This unit aims to give students an understanding of the planning and scheduling involved in project
management.
Main Topics of Study:
Introduction
► Environmental issues
► Distinguishing planning and scheduling
► Planning time frame
► Matrix charts
► Tabular planning
► Bar charts
► Line of balance charts
Network Analysis, Logic Diagrams and the Critical Path
► Network notation systems
► Critical path analysis and arrow diagrams
► Critical path analysis and precedence notation
► PERT
► Network notation
Network Analysis in Practice
► Developing network logic
► Level of detail in network planning
► Interface activities and events
► Milestones
► Estimating activity durations
► Network analysis as a management tool
Scheduling Resources – Principles
► Resource scheduling
► Network analysis
► Float
► Fundamental priority rules
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► Elements of a practicable schedule
Scheduling Resources in Practice
► Choice of labour resources
► Choice of resource units
► Rate-constant and non-rate-constant
► Specifying Departmental Resource Availability Levels
► Calendars
► Scheduling labour costs
► Scheduling material costs
► Scheduling cash flow
► Seven steps of project resource scheduling
► Corporate context
Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Describe the primary techniques involved in planning projects.

2.

Utilise network analysis techniques in establishing a critical path.

3.

Use networks in the scheduling and resource allocation.

4.

Relate network techniques with costing and budgeting of projects.

Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the
learning outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Project Management, Dennis Lock, Gower
Alternative Texts and Further Reading
Project Management: Planning & Control, Rory Burke, Wiley
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Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
These interactive sessions will be used to discuss concepts and allow students to
present findings.

50 hours

Directed learning
Advance reading and preparation / Background research / individual and group
preparation for seminars.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the tutor
and other students and to undertake further reading using the web and/or libraries.

Project Management

26

13.1.5 Purchasing & Materials Management Syllabus

Unit Title

Purchasing & Materials Management

Unit Code

PMM-0913

Level

6 Diploma

Credits

20

Unit Leader

KE

Pre-requisites
Main Aim(s) of the Unit:
This unit is designed for students involved in the purchasing and materials management of project
management.
Main Topics of Study:
Scheduling Parts for Manufacturing Projects
► Scheduling framework
► Collating material requirements
► Line of balance
► Computer solutions
Purchasing – Principles and Initial Ordering
► Purchasing and materials control
► Purchasing cycle
► Purchase order; commercial conditions of purchase
► Incoterms
► Specifying the goods
► Timing of orders and & deliveries
► Purchase quantities
Purchasing – Post Order Activities and Materials Control
► Purchase order amendments
► Expediting
► Shortages
► Pareto principle and stock management
► Project or stock purchasing
► Project purchasing as a condition of contract
► Stores administration
► Materials management as shared or common service
Purchasing – Procedures for Capital Projects
► The purchasing organisation
► Purchase control schedules
► Purchase specifications
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► Purchase enquiries
► Bid evaluation
► Purchase requisitions and orders
► Specification
► Enquiry and order numbers
► Quality and progress
► Vendors’ documents
► Shipping, port and customs formalities
► Purchase order status reports
Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Understand the elements of ordering and scheduling parts.

2.

Compare and contrast post ordering techniques and materials control.

3.

Use appropriate techniques in purchasing procedures for capital projects.

Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the
learning outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Project Management, Dennis Lock, Gower
Alternative Texts
Purchasing Systems & Records, P. Baily, Gower
Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
These interactive sessions will be used to discuss concepts and allow students to
present findings.

50 hours

Directed learning
Advance reading and preparation / Background research / individual and group
preparation for seminars.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the
tutor and other students and to undertake further reading using the web and/or
libraries.
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13.1.6 The Financial & Commercial Framework Syllabus

Unit Title

The Financial & Commercial Framework

Unit Code

FCF-0913

Level

6 Diploma

Credits

20

Unit Leader

KE

Pre-requisites
Main Aim(s) of the Unit:
This unit aims to give students the ability to manage the financial and commercial framework of
project management.
Main Topics of Study:
Defining the Project
► Receipt of customer enquiries
► Screening enquiries
► Defining projects
► Defining a project for financial appraisal
► The customer’s project specification
► Project scope
► Using checklists
► Project and design specifications
► Product development projects
► Developing the project specification
Cost Estimates – Definitions and Principles
► Estimating accuracy
► Classification of estimates
► Prices and profits
► Version cntrol
► Work breakdown
► Cost coding systems
► Benefits of a coding system
► Choosing a coding system
► Customer requirements and coding
Cost Estimates-Estimating in Practice
► Compiling the task list
► Level of detail
► Estimating formats
► Estimating manufacturing costs
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► Estimating labour time
► Personal estimating characteristics
► Material and equipment costs
► Below the line costs
► Reviewing cost estimates
Commercial Management
► Financial project appraisal
► Project funding
► Contracts
► Contract payment structures
► Insurance
Learning Outcomes for the Unit:
At the end of this Unit, students will be able to:
1.

Use a number of techniques to define projects and develop project specifications.

2.

Compare and contrast approaches in costing and estimation prior and during the life of a
project.

3.

Examine the methods of contracts and project funding.

Learning and teaching methods/strategies used to enable the achievement of learning
outcomes:
Learning takes place on a number of levels through lectures, class discussion including problem
review and analysis. Formal lectures provide a foundation of information on which the student builds
through directed learning and self managed learning outside of the class. The students are actively
encouraged to form study groups to discuss course material which fosters a greater depth learning
experience.
Assessment methods which enable the student to demonstrate the learning
outcomes for the Unit:

Weighting:

Examination: 3 hours duration

100%

Indicative Reading for this Unit:
Main Text
Project Management, Dennis Lock, Gower
Guideline for Teaching and Learning Time (10 hrs per credit):
50 hours

Lectures / Seminars / Tutorials / Workshops
These interactive sessions will be used to discuss concepts and allow students to
present findings.

50 hours

Directed learning
Advance reading and preparation / Background research / individual and group
preparation for seminars.

100 hours

Self managed learning
Working through the course text and completing assignments as required will take up
the bulk of the learning time. In addition students are expected to engage with the tutor
and other students and to undertake further reading using the web and/or libraries.

Project Management

30

